INTRODUCTION TO DIGITAL ANALYSIS TECHNIQUES:
A WORKBOOK FOR THE PRESS AND AMERICAN SOCIETY, 1836-1922
A THIRD-YEAR HISTORY MODULE AT SHEFFIELD HALLAM UNIVERSITY

Composed and Compiled by
M. H. Beals, Senior Lecturer in History at Sheffield Hallam University

With Additional Materials and Insights Provided by
Helen Steele, Research Information Advisor, University of Leicester

This work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
Please link all attributions to M. H. Beals, The Socratic Dilemma, http://mhbeals.com/?p=4242
A WORD OF INTRODUCTION

This workbook contains twelve worksheets, designed to compliment a twelve-week, third-year module on the relationship between the American press and society. They are hereby released under the CC-BY-NC-SA license and may be reused freely in other non-commercial educational contexts. Any material adapted from this workbook and released publicly must do so under the same license.

REQUIREMENTS

With the exception of the Microsoft Office Suite, all activities below were undertaken using Google Drive and the following free software packages and websites

- BatchGeo: http://www.batchgeo.com
- AntConc: http://www.antlab.sci.waseda.ac.jp/software.html
- WCopyFind: http://plagiarism.bloomfieldmedia.com/z-wordpress/software/wcopyfind/
- 750 Words: http://www.750words.com

PROVISOS

These worksheets were written to reinforce and clarify verbal instructions and face-to-face support given during weekly, two-hour computer seminars. They may, therefore, reference material delivered in weekly lectures, or the required reading, and should not be reused in other modules without revision.

Likewise, the aim of this module was to introduce students to the concept of computer-aided analysis without overwhelming them with technical detail or cumbersome commercial software. Therefore, the techniques below have been simplified and should not be taken as complete representations of the power or nuance of these methodologies.

ACKNOWLEDGEMENTS

The techniques and materials below were inspired by a number of past experiences and encounters, not all of which can be distinctly identified. However, I would like to particularly thank Helen Steele, University of Leicester, for her assistance in developing the 'Finding Specialised Reading' worksheet, and to James Baker, British Library, for his recommendation of the AntConc concordance software.

It is my hope that my efforts here will aid you in your own digital history endeavours. If you adapt or re-use these materials, I would be eager to hear your results.

M. H. Beals
Sheffield Hallam University
May 2014
<table>
<thead>
<tr>
<th>Digital Methodologies</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Chronicling America Database</td>
<td>4</td>
</tr>
<tr>
<td>Institutional and Editorial Biographies</td>
<td>7</td>
</tr>
<tr>
<td>Geo-visualisation</td>
<td>10</td>
</tr>
<tr>
<td>Topic Modeling</td>
<td>15</td>
</tr>
<tr>
<td>Reprint Analysis</td>
<td>19</td>
</tr>
<tr>
<td>Discourse Analysis</td>
<td>24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Research and Writing</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finding Specialised Reading</td>
<td>29</td>
</tr>
<tr>
<td>Reviewing Your Methodologies</td>
<td>32</td>
</tr>
<tr>
<td>Analysing Your Writing Digitally</td>
<td>34</td>
</tr>
<tr>
<td>Formatting Your Work Digitally</td>
<td>37</td>
</tr>
<tr>
<td>Presenting Your Work Online</td>
<td>42</td>
</tr>
<tr>
<td>Visualising Your Research for Employers</td>
<td>44</td>
</tr>
</tbody>
</table>
USING THE CHRONICLING AMERICA DATABASE

TASK 1: NAVIGATING WORKSHOP MATERIALS

Go to the module’s Blackboard site

- Click on Learning Materials link on the left hand side of your screen
- Click on Workshop Materials
- Here you will find all the relevant links and documents to assist you with our workshops
- Click on the link to the Module's Collaborative Google Drive Folder
- If you have not already, sign into Google using your student email address
- Click on the blue Open in Drive button in the upper right hand corner of your screen

TASK 2: NAVIGATING THE DATABASE

Go to Chronicling America Website, http://chroniclingamerica.loc.gov/

- Visit the Advanced Search Tab. Examine its contents closely

Answer the following questions within Workshop Quiz 1.1 (link on the Workshop Materials site)

- Which ‘important’ states are missing from selection window?
- Which keys do you press to select more than one newspaper title?
- What is the difference between the two date search options?
- Is there any language option missing that you would expect from US newspapers?

TASK 3: EXPERIMENTING WITH SEARCH TERMS

- On the Advanced Search tab of the Chronicling America Website and enter the following keywords into the ...with any of the words box: Battle of the Alamo
- Open a new tab or window to the Advanced Search tab of the Chronicling America Website and enter the following keywords into the ...with all of the words box: Battle of the Alamo
- Open a new tab or window to the Advanced Search tab of the Chronicling America Website and enter the following keywords into the ...with the phrase box: Battle of the Alamo
- Open a new tab or window to the Advanced Search tab of the Chronicling America Website and enter the following keywords into the ...with the words within 10 words of each other box: Battle of the Alamo

Move between these four sets of results. What are the differences in the first few hits?

- Open a new tab or window to the Advanced Search tab of the Chronicling America Website and enter the following keywords into the ...with the phrase box: Battle of the Alamo.

Set Select Years to 1836 to 1848

Move between these five sets of results. Besides the obvious change in date, what sort of differences do you notice in the types of articles that are returned?

You can now close these tabs if you wish
Open a new tab or window to the Advanced Search tab of the Chronicling America Website and enter the following keyword into ...with any of the words box: Alamo

Set Select Years 1836 to 1848
Set Select State to South Carolina

Open a new tab or window to the Advanced Search tab of the Chronicling America Website and enter the following keyword into ...with any of the words box: Alamo

Set Select Years 1836 to 1848.
Set Select State to New York

Move between these two sets of results. Besides the obvious change in location, what sort of differences do you notice in the types of articles?

Answer the following questions within Workshop Quiz 1.2 (link on the Workshop Materials site)

- What would be a good use of the “any of the words” option?
- What would be a good use of the “all of the words” option?
- What would be a good use of the “with the phrase” option?
- What would be a good use of the “within so many words of each other” option?
- Why would you limit the dates the year something happened?
- Why would you limit the dates to a different period?

**TASK 4: HOW TO TRANSCRIBE AN ARTICLE AND WHERE TO PUT IT IN THE MODULE SPREADSHEET**

Return to the Module’s Collaborative Google Drive Folder

- Open the Full Transcription Database spreadsheet file
- At the top of this worksheet, you will have a number. Go to that row number in the spreadsheet
  
  In the Compiler column enter your first initial, followed by your surname

  As this is a collaborative file, you will be able to see what other people are editing as they edit. In the future, if you find yourself ‘fighting’ over a row, write a message to the other person (they can see everything you type) explaining that you would like this cell or are moving to another row. There are plenty of rows for everyone

  Enter a transcription number in the Transcription column. This should be the row number +1

- Open a new tab or window to the Advanced Search tab of the Chronicling America Website enter the following keyword into ...with all of the words box: Alamo Houston

- Choose an article that you find interesting. Return to the Full Transcription Database and have a look at what other people are typing. Is someone else doing the same article as you? If they are nearby, have a quick word and decide who will continue with that article, and who will look for something else. If they are not, and they are still typing, you should choose another article

  If no one else has already claimed this article, fill out the rest of your row including the Year, Month, Date, Newspaper title, Newspaper City, Newspaper State, Topic City, Topic State, Page and the number of First Column your article appears in

  Enter the Headline, if there is one, and the first line of text

  Copy (Cntl+c) and paste (Cntl+v) the link to the webpage containing your article into the final column
Return to the Module's Collaborative Google Drive Folder

- Click on the Transcriptions folder
  
  Click on the red "Create" button in the upper left-hand side of your screen, and choose Document
  
  Click on the phrase "Untitled Document" and rename the file your transcription number

- Dock (Windows Key+Right Arrow) your document to the right-hand side of your screen

- Dock (Windows Key+Left Arrow) the website image of your article to the left-hand side of your screen

- Carefully transcribe the entire article, including the headline, into your document, retaining any mistakes or misspellings
  
  Your file will auto save every few seconds

- When you have finished, click the blue "Share" button in the right-hand corner of your screen
  
  Copy (Cntl+c) and paste (Cntl+v) the URL to your transcription, and place it in the final column of your entry in the Full Transcription Database
INSTITUTIONAL AND EDITORIAL BIOGRAPHIES

TASK ONE: IDENTIFYING TITLES

Visit the Module Blackboard Site

- Click on Learning Materials, and then Workshop Materials
  - Open the Workshop Quiz 2.1

In a new tab, visit the Chronicling America website. Click on the US Newspaper Directory 1690-Present

- In the keywords box, enter 'United States Telegraph' and hit Search
  - What sort of information does the Catalogue Record tell you about the Newspaper?

Visit the American Antiquarian Society’s online catalogue (http://catalog.mwa.org)

- In the search box, enter “United States Telegraph” including speech marks
  - You will find a selection of pamphlets and circulars that mention the newspaper. Choose (click on) one from the 1820s or 1830s and read its full title by clicking on the More about This Item button
  - What does this pamphlet tell you about the newspaper?

Return to the Module Blackboard Site

- Click on the Reading List and visit the Resource List Online Page
  - Under Reference Works, click on Historical Dictionary of Journalism and then Access the eBook
    - Click on The Dictionary Under the Table of Contents
    - Click on the Search Tab, and search for “United States Telegraph” including speech marks
      - ‘Flip’ backwards and forwards several pages. What sort of things does this dictionary have entries on?

Visit Google Books (http://books.google.com)

- Use the following search terms, including punctuation marks:
  
  “United States Telegraph” “Washington, D.C.” Newspaper

  Which sorts of books mention this newspaper?
  - What sort of information about this paper can you expect to get from these books?

Visit the Learning Centre Library Search

- Search for “United States Telegraph” including speech marks
  - Refine your search by clicking on ‘Peer Review’ and ‘Journal Article’

  What sort of material do academic journals provide on this newspaper?

TASK TWO: IDENTIFYING EDITORS

Visit the Chronicling America website. Click on the US Newspaper Directory 1690-Present

- In the keywords box, enter 'United States Telegraph' and hit Search
- Look through the relevant records (those starting 1826 or 1827)
- Who were the three editors / publishers of the United States Telegraph?
Visit the Learning Centre Library Search

- Search for all three editors. Only one will yield relevant results
  
  What sort of material does the *Encyclopaedia Britannica* provide on this editor?

Return to the Historical Dictionary of Journalism

- In the search box, enter the name of the editor in speech marks
  
  What sort of material does the *Historical Dictionary* provide?

Visit Google Books (http://books.google.com)

- In the search box, enter the name of the primary editor in speech marks
  
  Which sorts of books mention this editor?

- Take a Closer Look at the Recent Biography (Belko)
  
  Look up all three editors using the search within the book function (on the left-hand side of your screen).
  
  What is the relationship between them?

Visit the American Antiquarian Society's online catalogue (http://catalog.mwa.org)

- In the search box, enter the name of the primary editor in speech marks
  
  You will find a selection of pamphlets and circulars that mention the editor. Choose (click on) one from the 1820s or 1830s and read its full title by clicking on the More about This Item button.
  
  What does this pamphlet tell you about the editor?

**TASK THREE: CREATING A TITLE REFERENCE SHEET**

Visit the Module Collaborative Google Drive

- Open the Full Transcription Database spreadsheet file
  
  Choose one of the newspapers listed in the spreadsheet

- In a new tab, open the Biography folder
  
  - Check to see that no document has been created regarding this newspaper. If it has, return to the database and choose another newspaper
  
  - Create a new document by clicking the red Create button in the upper left-hand side of your screen and clicking on Document. Click Create and Share to confirm
  
  - Retitle the file by replacing the text "Untitled document" with the name of your newspaper. If it begins with an article (An, The, A) omit this and place it at the end (, The)
    
    Complete the title with the City and State in parentheses, followed by the relevant dates
    
    Your title should look at follows: Meigs County Times, The (Pomeroy, Ohio) 1843-1848
• In the body of your document, discover and insert the following information, to the best of your ability. Not all titles will allow you to complete all questions
  o Title
  o Alternative Titles
  o Place of publication
  o Geographic coverage
  o Publisher / Editor (Years that he/she was held the position)
  o Dates of publication
  o Frequency
  o Language
  o Preceding Titles
  o Succeeding Titles
  o Related Titles
  o Political Affiliation
  o Important Contributors
  o Important Patrons (Funders)
  o Controversies or scandals
  o Any other useful information
• After each piece of information, enter a short reference to your source in parentheses

TASK FOUR: CREATING A BIOGRAPHY

Visit the Module Collaborative Google Drive
  • Open the Biography folder
  • Create a new document by clicking the red Create button in the upper left-hand side of your screen and clicking on Document. Click Create and Share to confirm
  • Retitle the file by replacing the text "Untitled document" with the name of your editor. It should be arranged last name first, with dates of birth and death in parentheses
    o Green, Duff (1791-1875)
• In the body of your document, discover and insert the following information, to the best of your ability. Not all individuals will allow you to complete all questions. If you cannot complete the first 5 questions, you will need to choose another individual
  o Full Name
  o Date and Place of Birth
  o Date and Place of Death
  o Employment History
  o Political Affiliation
  o Important business connections
  o Important family connections
  o Important causes or political stances (such as abolition, temperance)
  o Any other biographical details relevant to political or printing career
GEO-VISUALISATION

TASK ONE: USING EXISTING DATA

Visit the Module Collaborative Google Drive

- Right-click on the box next to the Full Transcription Database
  Choose Download, and download as a Microsoft Excel (.xlsx) spreadsheet
  Save the file to your desktop (or wherever you will find it most easily)
  - If it does not give you an option of where to save it, it will be in your Downloads folder, which you can find by typing Downloads in the Run Box at the bottom of your Start Menu (Windows Button + r). If you hit Open, rather than Save, it will save in a temporary directory and be difficult to retrieve.

- Open the downloaded version of the Full Transcription Database
  Highlight the second column (by clicking on B). Once highlighted, right-click on it and select Delete
  Highlight the Headline and First Line columns, and delete
  Now delete Category, Notes, and Original
  You should now have twelve (12) columns
  Remove any incomplete rows (right-click on the row number and select Delete)
  Finally, click on the first cell of the first column (Year) and then click the Sort and Filter button at the top right-hand side of your screen. Choose Smallest-to-Largest
  Highlight all the data (Cntl+A) and copy (Cntl+C)

TASK TWO: CREATING A BASIC VISUALISATION

Visit the BatchGeo website (http://www.batchgeo.com/)

- Click on the spreadsheet box and then paste (Cntl+V) your data into it
- Click on Validate & Set Options
  - Region: United States
  - Location / Address: None
  - City / County: Newspaper City
  - State / Province / Postcode: Newspaper State
  - Zip / Postcode / Country: None
  - Group By / Thematic Value: Year
- Click Show Advanced Options
  - At the bottom, click on the image of the circle
  - Check Enable clustering for high density makers and set label to Numbers
- Click Make Map

Now that your map is compiled, you can click on different date ranges and this will bring up different combinations of icons. You can also click on the drop-down menu in the map legend (currently reading year) and chose a different variable.

If there are multiple hits in a single area, you will see a pie-chart with the different months represented. Click on a pie chart to zoom in and see the hits in more detail. Do different regions seem to post stories on Texas / the Mexican-American War in different parts of the year or is there an even spread? Why might your conclusions be (currently) flawed?
TASK THREE: CREATING DATA FROM MATERIALS

Visit the Module Blackboard Site
- Under Learning Materials, Workshop Materials, right-click on the AntConc program
- Choose Save Link As and save to your Desktop

Return to the Module Collaborative Google Drive
- Right-click on the box next to the Transcriptions folder
- Choose Download, and download Plain Text
  - This will take 15-30 seconds
  - When it is ready, Open File and drag the folder from the zip folder onto your Desktop

Find the AntConc Program (antconc.exe) on your Desktop and run it
- Click File, and then Open Dir
  - Choose the Transcriptions folder on your desktop
- You should now have a list of numbered text files in the left-hand box
- Click on the Word List tab, and then hit Start
  - This is a list of every word in the entire Transcriptions folder. The most common words (the, of, and) will be first, but scroll down the list to see some of the more unusual words (fewer than 100 hits)
- As a group (row) choose one of the less common words (such a person or place name) and click on it
  - This will take you to the Concordance tab. A concordance is a list of every instance of the word. You will see the context the word appears in each instance and the transcription file it is from
- Click on the first file name in the right-hand box, and then select all (Cntl+A) and copy (Cntl+C)

Open a new Excel Document (or a new tab in your existing Excel Document)
- Paste (Cntl+V) the data into the spreadsheet, and delete the second and third column
- Select (Highlight) the column and click on the Data tab at the top of your screen
- Click on Remove Duplicates, and click OK
  - You should now have a smaller list of numbers, with no duplicates

Go back to your original Excel spreadsheet (Full Transcription Database)
- Using the smaller list of numbers, remove all the unnecessary rows (those not listed in your small list)
- Select All (Cntl+A) the remaining list, and copy (Cntl+C)

TASK FOUR: CREATING A VISUALISATION FROM YOUR NEW DATA

Return to BatchGeo, and scroll to the top of the page.
- Select the spreadsheet box, and Paste (Cntl+V) your new data
- Click Map Now
**TASK FIVE: DEVELOPING A COLLABORATIVE INTERPRETATION**

**TO BE DONE AS A GROUP ON ONE COMPUTER**

Chat with your group for a moment about the results you have found

- Do you notice any patterns when you select different years, months, or page numbers?
- Do you notice any obvious gaps in your options (such as no summer months, or front pages)?
- Make a hypothesis (guess) based on the data you have so far. For example
  - News about this topic appeared in coastal cities in the early years and inland cities later on
  - News reached cities along the Mississippi throughout the year, but other places in autumn
  - The Great Lakes (around Chicago) did not care about this topic until the very end of the period

Go to Chronicling America website.

- Visit the Advanced Search Tab
  - Set Select Years 1836 to 1848
  - Enter your keyword (that you used in AntConc) into the all words search, along with any other words you think are relevant. For example:
    - For Annexation or Goliad, you would probably also want to include Texas
    - For Clay, you would probably also want to add Henry and Texas or War
  - Add any other limits necessary to test your hypothesis
    - For example, if you only care about a particular state, click on the state
- Click Search
  - You will probably receive a large number of hits. If you receive more than 100, you may want to go back and add more words to further limit the search
  - Click on the List Icon at the top of the results gallery
  - Sort by Date rather than Relevance and change Results per Page to 50
  - Select (highlight) the list and copy (Cntl+C)

Open a new Excel document or a new tab in your existing one

- Click on the first cell
- Click on the arrow underneath the Paste Button and click Match Destination Formatting
- Highlight the first column, and then click on the Data tab, followed by Text to Columns
  - Click next, then select Comma and Other
  - Place a ( in the Other box
  - Click next, finish
- Add a row to the top of your spreadsheet (highlight first row, right-click and select Insert)
- Label your columns (Newspaper, City, State, Month, Year, Page)
- Clean up any mistakes
  - Move cells over if they are in the wrong column, find and replace ), remove numbers from month column, and so on
- Select all (Cntl+A) and Copy (Cntl+C)
Return to the Google Module Collaboration Folder

- Open the Geovisualisation Folder and create a new spreadsheet
- Paste (Cntl+V) data into new spreadsheet
- Rename the spreadsheet to something appropriate (such as the keywords and other limitations used)

**TO BE DONE SEPARATELY ON INDIVIDUAL COMPUTERS**

Go to Chronicling America website

- Bring up the same search and view parameters that you did as a group

Go to the Google Module Collaboration Folder

- Open the Geovisualisation Folder and your group spreadsheet
- Add your initials to the empty cell at the end of a row (each chose a different row)

View this article on the Chronicling America website

- Looking over it very quickly, check that it is relevant to your hypothesis (is it on the right topic?)
- If it is not, delete the row from the collaboration worksheet
- If it is, enter your initials on another row, and check that article as well
- Continue until your group has checked the entire list
- Select All (Cntl+A) data and Copy (Cntl+C)

Return to BatchGeo, and scroll to the top of the page.

- Select the spreadsheet box, and Paste (Cntl+V) your new data
- Click Map Now

**ONE GROUP MEMBER**

Return to the Geovisualisation Folder and create a new Document

- Rename the document to the same title as your spreadsheet
- Write your hypothesis at the top of the document
- Return to BatchGeo

**ALL GROUP MEMBERS**

Under your map, click Save and Continue

- Enter your title and email address. This will email you a link to go back to it later
- Keep the map Unlisted and hit Save Map

You are now on a saved version of your map. Use the dropdown menu to choose the variable that best answers your question (was it about years, months, pages?)

- Each member of your group should chose a different value (June, July, May)
- Click on the Print Screen (PrtScn) button on your keyboard
Return to your Geovisualisation Document (open it if you have not done so already)

- Type your Name (or initials) so that each of you have your own line
- Create a blank line under your name
- Hit Paste (Cntl+V)

After a moment, an image of your map should appear

Underneath, write a line or two describing your results.

What does this map tell you about your hypothesis? Was it right? Wrong? Unclear?

- Look at all the maps in the document.

Working together, create a few lines at the bottom of your document to explain if your hypothesis appears to be correct, incorrect, or requires more information. If so, what would you need? What sort of contextual information would help you understand this data better?
TOPIC MODELING

TASK ONE: UNDERSTANDING WHAT A TOPIC MODEL IS

Look at the two articles I have given you

- Read through them
- Now circle, highlight or underline five words that appear in both texts
  - The words should
    - Not be stop words (and, of, the, a)
    - Having something, in your opinion, to do with the topic of the article

When you are both done, turn to the person next to you

- In turn, share your words with the other person
  - What do they think your articles are about based on your five words?
- Explain to them what they are actually about (if they guessed incorrectly)
- Explain why you chose the words you did
- If you entered these words into the Chronicling America search, would they give you similar articles?

TASK TWO: GATHERING MATERIALS

Make sure any Transcription or Spreadsheet files from previous weeks are deleted from your desktop

Visit the Module Collaborative Google Drive
- Tick the boxes next to the Full Transcription Database and the Transcriptions folder
- Right-click and choose Download (as a Microsoft Excel (.xlsx) spreadsheet and Plain Text (.txt))
- When given the option, open the downloaded file
  - Drag and Drop the Database and Transcriptions folder onto your desktop
    - If you leave them in the zip folder the program will not work

Return to the Module Collaborative Google Drive

- Open the Workshop Links Document
  - Follow on the link under Topic Modeling Program
    - When given the option, right-click the top link (TopicModelingTool.jar) and Save As to your desktop

Make sure you have AntConc on your desktop. If not, re-download it from the Workshop Links
TASK THREE: CREATING TOPICS

Run the Topic Modeling Tool

- Click Select Input File or Dir
- Select your Transcriptions folder
- Click Select Output Dir
- Right-click in white space and click New Folder and name the new folder "Output"
- Select your Output folder and click Open
- Click Learn Topics
- Minimise the Topic Modeling Tool

Open your Output folder

- Open the output_csv folder
- Open the Topics_Words.csv file
- On each line, replace the number with what you think is a good description of these words.
  - What sort of thing do you think each group of words is probably referring to?
    - For example: egg, bake, stir, spread, salt, whip might be cooking
    - There is no wrong answer
    - If you need to, resize the first column by double clicking on the line between A & B

TASK FOUR: PLACING ARTICLES WITHIN THOSE TOPICS

Return to your Output_csv folder

- Open the TopicsInDocs.csv file
  - Delete the first column (highlight, right-click, delete)
  - Resize the (new) first column by double-clicking on the line between A and B
  - Rename your columns
    - Filename: Transcription
    - top topics: Topic
    - and contribution to doc: Percentage
    - “Column D”: Second Topic
    - “Column E”: Second Percentage
  - Delete remaining columns (These are very low percentages and probably not as relevant)
- Highlight and Copy (Cntl+C) all the document filenames in the first column
  - Paste (Cntl+V) the list of files into the first empty cell in the first column
    - You should now have a double length list in column A
• Highlight and Cut (Cntl+X) all the rows in your Second Topic and Second Percentage columns (not including the header/label row)
  o Paste (Cntl+V) the list in the first empty cell in the second column
  o Delete the Second Topic and Second Percentage columns
• Highlight your Percentage column and click the Percentage Icon (%) near the top middle of your screen, above the word “Number”
  o Click on the column label Percentage and then click Sort and Filter followed by Custom Sort
  o Make sure "My data has headers" is checked and then select Largest to Smallest (or Z to A) and hit OK
  o Delete any rows where the percentage is less than 20%
  o Click on the label Main Topic and then click Sort and Filter followed by Custom Sort
  o Make sure "My data has headers" is checked and then select Smallest to Largest (or A to Z) and hit OK

**TASK FIVE: MAKING SENSE OF THE TOPIC MODEL**

In pairs or threes, choose one of the topic numbers and highlight the relevant rows on each computer

Everyone open your Transcription Folder

- Open the relevant transcriptions
- Scan through them quickly
  o What do they seem to be about?
  o What topic do they seem to have in common, even if they also talk about different things?

Everyone return to the Topics_Words.csv file (where you named the ten topics earlier)

- Look at what you originally named that topic. Were you right? Can you think of a better name for it now?
- Discuss with your partner(s) what your original name was, and what you think should be called now

On one computer, run the AntConc Concordance Program

- Click File, and then Open Dir
  o Choose the Transcriptions folder on your desktop
- Stay on the Concordance tab, and insert a word into the search box
  o The word should be the one from the topic list that best encompasses this topic
- Click Start
  o Your list will (hopefully) be longer than your topic model list.
- Choose a file from the list that you have not already looked at
- Click on the File View tab
  o Click the file you want (from the list of the left-hand side)
    - Should this file have been in the topic?
    - Is it slightly different in tone or content?
Using topic modeling will help you find articles that share common characteristics based on statistical models, rather than just your biases / gut feelings. This will help you choose relevant primary sources for a given topic (paragraph) of your essays without having to reread a very large number of articles based on keywords, which may have (many) irrelevant matches and miss out relevant ones.

However, computers are only as intelligent as humans make them! If we (by our choice of transcriptions and search terms) create biases in our data, the computer cannot remove these. It can only work with what we give it.

You can now close all open windows

**TASK SIX: GRAPHING A TOPIC MODEL**

In some cases, you can graph a topic model and it will give you interesting results

Open your Output folder (on your desktop)

- Open the output_html folder
- Choose a topic number and open the relevant html file
- Highlight all the rows that have at least 10 hits (the number in parentheses)
- Copy (Cntl+C) and Paste (Cntl+V) these into a blank Excel Spreadsheet
- Delete all the columns except the one with the file names
- Sort the list Smallest to Largest (Using Sort & Filter button)

Open (in Excel, not Google Docs) your Full Transcription Database (on your desktop)

- Using the smaller list of numbers, remove all the unnecessary rows (those not listed in your small list)
- Delete all columns except Year and Month
- Sort by Year
- Choose the two consecutive years with the largest number of entries
- Delete all the other rows (so only those two years are left)
- A few rows underneath your list, write out the years and months for your two years
  - Next to each year/month, input how many hits/instances you have in your list

<table>
<thead>
<tr>
<th>When</th>
<th>Articles</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 1845</td>
<td>1</td>
</tr>
<tr>
<td>February 1845</td>
<td>0</td>
</tr>
<tr>
<td>March 1845</td>
<td>0</td>
</tr>
<tr>
<td>April 1845</td>
<td>3</td>
</tr>
<tr>
<td>...and so on, until...</td>
<td>2</td>
</tr>
</tbody>
</table>

- Highlight your When/Articles table
- Click on the Insert tab and click on the bar graph

You now have a timeline for how often this topic appeared in the press for your two years (within our sample). This may help you understand and explain something about the press coverage on this topic in your essay.
REPRINT ANALYSIS

TASK ONE: GATHERING MATERIALS

Make sure any Transcription or Spreadsheet files from previous weeks are deleted from your desktop.

Visit the Module Collaborative Google Drive
- Tick the boxes next to the Full Transcription Database and the Transcriptions folder
- Tick the box next to the Common Newspaper Words file
- Right-click and choose Download (as a Microsoft Excel (.xlsx) spreadsheet and Plain Text (.txt))
  - When given the option, open the downloaded file and drag files to your Desktop

Return to the Module Collaborative Google Drive
- Open the Workshop Links Document
- Follow on the link under Reprint (Plagiarism) Tool
- When given the option, Save As file (WCopyfind.4.1.1.exe) to your desktop

If you no longer have AntConc on your desktop, please re-download it from the Workshop Links Document

TASK TWO: FINDING COPIES WITHIN AN EXISTING DATA SET

SUB-TASK A: COLLECTING THE DATA

Open WCopyFind
- Right-click in the Bottom white box, and choose Browse for Documents
- Navigate to your transcriptions folder (on your desktop) and click open
- Select all the documents (click on any of them and then press Cntl+A) and click open

Set parameters for your search
- Shortest Phrase to Match: 5 (it will have to have at least one 5-word duplicate)
- Fewest Matches to Report: 100 words (it will have to have 100 matching words – 20 sets of 5)
- Most imperfections to Allow: 10 (allows for typing errors, yours and theirs)

Tick the following options:
- Ignore all punctuation
- Ignore numbers (reprints often write “one” for “1” to or vice versa)

Next to "Folder for the Report Files", click Browse
- Navigate to your desktop and click Make New Folder
- Name the new folder Reprints and click OK

Click Run
- This will automatically open a report HTML in your browser
- You should have a number of reprints listed. Choose one and click Side-by-Side
- This will show the two files side-by-side, highlighting the text that appears in both in red
- Clicking on a phrase on the right-hand side will zoom to the that same text in the left (and vice versa)
SUB-TASK B: UNDERSTANDING THE DATA

Open the Full Transcription Database (on your desktop) and highlight the relevant rows by clicking the row number and then pressing the Fill Cell button at the top of your screen (the Yellow Bucket)

- Click on the top left cell (Transcription No) and click Sort and Filter, Custom Sort
  - Sort by: Transcription No
  - Sort On: Cell Color
  - Order: Yellow, On Top

Using the side-by-side comparison and the Full Transcription Database, answer the following questions in Workshop Quiz 5.1 (available via the Blackboard Site):

- Are these legitimate reprints (or did two people do the same file)?
- Which newspaper printed the text first?
- How long of a delay is there between the reprints?
- Does the second cite or reference the first?
- Does either article reference a source?
- Is the material said to be a letter or ‘from a friend’?
- Is it said to be from another newspaper?
  - Is this newspaper available via Chronicling America?
    - Visit http://chroniclingamerica.loc.gov/newspapers.txt and search (Cntl+F)
      - Be generous in how you search. Indiana Sentinel refers to Indiana State Sentinel, so search for Sentinel and click through until you see an Indiana one from the right dates. New York is often written New-York
- What sort of material is added or removed in each reprint?
- Make sure to look at the original image in case the transcriber omitted the beginning or end
- Have any interesting words (emotional adjectives or adverbs) been added or removed?
- Do the headlines (especially the tone of the headlines) change?
- Who do you think copied from whom?
  - The newer one from the older one
    - Older \(\rightarrow\) Newer
  - Both the older and newer one from a third one (in another newspaper)
    - \(\rightarrow\) Older
    - Original \(\rightarrow\) Newer
  - Each from different sources
    - Original \(\rightarrow\) Older Original \(\rightarrow\) Older
    - \(\rightarrow\) Different Older Original \(\rightarrow\) Newer
- What does the order and time delay of the reprinting tell you about the information in the article?
TASK THREE: FINDING COPIES WITHIN CHRONICLING AMERICA

SUB-TASK A: FINDING MORE OF THE SAME

Open a new Excel spreadsheet

- Find three (3) or four (4) phrases of at least five (5) words from the article text that appear to have been faithfully copied in each reprint
- Copy (Cntl+C) and Paste (Cntl+V) these phrases from the side-by-side comparison into your new excel spreadsheet, one in each column

Visit the Chronicling America website (http://chroniclingamerica.loc.gov/)

- Go to the Advanced Search
- Place one of the phrases in the with the phrase search box.
  - Make sure nothing else is selected or changed from the default values
  - Search
  - Place the URL for any (relevant) results in a cell underneath the phrase in your spreadsheet
  - Repeat for all phrases
- If you don’t find any results (or only a very small number)
  - Go to the Full Transcription Database
  - Click on the Original link for one of the reprinted articles
  - On the Chronicling America Website, click on the Text link to bring up the OCR
  - Search (Cntl+F) for the phrase or the first few words of the article until you find the article
  - Look for the phrase you originally searched for to see how it has been computer-transcribed
  - Choose a few short phrases that seems intact (or consistently wrong, such as Tho for The)
    - Places these phrases into their own columns on your spreadsheet
- Go to the Advanced Search of the Chronicling America website
  - Place one of your new phrases in the with any of the words box
  - Limit the years to two years before and two years after the year of your reprints
  - Search
  - Place the URL for any (relevant) result in a cell underneath the phrase in your spreadsheet
  - Repeat for all phrases

If you were lucky enough to find a number of reprints, you can transcribe these and use them in you reprint analysis. If you were not, you will have to continue searching manually for sections of the article (for a reasonable length of time)

You may want to save a list of these URLs in your group folder, if you think they may be useful to your group-mates
SUB-TASK B: FINDING NEW REPRINT SETS

Run AntConc

- Click File, and then Open Dir
  - Choose the Transcriptions folder on your desktop
  - You should now have a list of numbered text files in the left-hand box
- Stay on the Concordance and click on Advanced next to the search box
- Tick the Use search term(s) from list below box
- Click Load File and choose CommonNewspaperWords.txt (on your desktop)
- Click Apply, then Start

This should give you a list of all the instances of common newspaper titles within our data set. Because they give you a bit of each sentence, you should be able to see which ones are relevant. Look down the list for common phrases such as

- From the *newspaper title*
- — *newspaper title*
- We find in the *newspaper title*
- According to the *newspaper title*

Choose one of the articles that has an attribution

- Return to the Chronicling America list of digitised newspapers at http://chroniclingamerica.loc.gov/newspapers.txt
- Search (Cntl+F) for the newspaper to see if it is available in the database
- If it is not available, choose another title

Return to the Chronicling America Advanced Search

- Under Select Newspaper(s), choose the newspaper your reprint is from
- Under Select Year(s), choose 5 years before your reprint (or as near as possible) and the year of your reprint
- Under any of the words chose two or three uncommon words that may bring up your article
- Search
- Look through the first few hits. Have you found your reprint?
  - If yes, you could (if you were doing your essay) transcribe and then compare the texts with WCpyFind
  - If not, keep looking or adjusting search terms as necessary

SUB-TASK C: FINDING REPRINT TRENDS (HAVEN’T I SEEN YOU HERE BEFORE?)

On the Chronicling America Advanced Search

- Under Select States(s), select all states by clicking on the top one, holding down shift, and then click on the bottom one
- De-select the state from which the reprint came (hold down Cntl and click on just that state)
- Under with the phrase, enter the name of your newspaper (as it usually appeared in references)
- Search
  - This will give you an idea of how commonly the newspaper was explicitly cited
  - You can also do this by selecting all other newspapers within the same state
TASK FOUR: FINDING COPIES BEYOND CHRONICLING AMERICA

SUB-TASK A: FINDING OTHER NEWSPAPERS

The Library of Congress is not the only online repository of pre-1922 newspapers. Using one of the newspapers listed in AntConc that was not available from Chronicling America, search for digital copies at these listings:

- Research Guide’s Historical Newspaper and Indexes: http://www.researchguides.net/newspapers.htm
- University of Pennsylvania’s Online Newspaper Listings http://guides.library.upenn.edu/historicalnewspapersonline
- Have a look at the search interface for this newspaper
  - Can you search for a specific phrase?
  - Do you have browse manually?
  - How easy do you think it would be to find your reprint here?

SUB-TASK B: FINDING NEW COPIES

In 2005, historian Patrick Leary suggested that we ‘Google the Victorians’ in order to find copies of 19th century texts in unexpected locations. So, that is what I am giving you permission to do.

Return to your side-by-side comparison. (It saved in the Reprint folder on your desktop if you closed it)

- Copy (Cntl+C) a few sentences of the highlighted text
- Paste (Cntl+V) it into Google
- What did you find?

In many cases you will find copies from other newspapers that other people have transcribed and uploaded. Or you may find that your article appeared previously (or later) in a book or magazine that has been made available on Google Books or Archive.org. This can help you identify the ‘original’ version as well as how it was interpreted and continued over time.
DISCOURSE ANALYSIS

TASK ONE: GATHERING MATERIALS

Make sure any Transcription or Spreadsheet files from previous weeks are deleted from your desktop

Visit the Module Collaborative Google Drive
- Tick the boxes next to the Full Transcription Database and the Transcriptions folder
- Right-click and choose Download (as a Microsoft Excel (.xlsx) spreadsheet and Plain Text (.txt))
- When given the option, open the downloaded file
  - Drag the Database and Transcriptions folder from the zip folder onto your desktop

Create two new folders on your desktop called Output and Reports

If you no longer have the Topic Modeling Tool on your desktop, please re-download it from the Workshop Links Document

TASK TWO: CHOOSING DOCUMENTS FOR ANALYSIS

SUB-TASK A: DOCUMENTS WITHIN A TOPIC MODEL

Run the Topic Modeling Tool
- Click Select Input File or Dir, Select your Transcriptions folder
- Click Select Output Dir
- Select your Output folder and click Open
- Change the Number of Topics to 100 and click Learn Topics

Minimise the Topic Modeling Tool and open the Output folder (on your desktop)
- Open the output_html folder and click on all_topics.html
- Look through a list and find a topic that seems relevant to you (or your group) and follow the link

Minimise the browser and open your Transcriptions folder (on your desktop)
- Dock (Windows key+left) the Transcriptions folder to one side of your screen and your browser to the other (Windows key+right)
- In your Transcriptions folder, create a make a new folder (Right-click on white space, New, Folder) and name it your topic keywords
- Using the list of files in your browser, highlight the top matches within your Transcription folder by holding down Cntl and clicking on each file individually.
  - Do not include any matches which have fewer than five (5) hits
  - Do not include more than five (5) matches for this exercise
- Copy the files (Cntl+c)
- Open the new folder you made (named after the topic words)
- Paste the files (Cntl+v)
SUB-TASK B: DOCUMENTS BY A PARTICULAR NEWSPAPER

Open the Full Transcription Database (on your desktop)

- Click on the header Newspaper and hit the Sort & Filter button on the top-right-hand-side of your screen
  - Choose A-to-Z or Smallest-to-Largest (whichever is available)
- If your cells are not evenly spaced: Select all (Cntl+a) and hit the Wrap Text button—at the top middle of your screen, to the left of the word General—twice
- Choose a newspaper title and highlight the relevant rows

Dock (Windows key+left) the Transcriptions folder to one side of your screen and your Excel spreadsheet to the other (Windows key+right)

- In your Transcriptions folder, make a new folder (Right-click on white space, New, Folder) and name it your newspaper title
- Using the list of files in your spreadsheet, highlight the top matches within your Transcription folder by holding down Cntl and clicking on each file individually.
  - Only select files on the same topic (use ‘Notes’ or the ‘Year’ column to decide)
  - Do not include more than five (5) matches (for this exercise)
- Copy the files (Cntl+c)
- Open the new folder you made (named after the newspaper title)
- Paste the files (Cntl+v)

TASK THREE: RUNNING SENTIMENT ANALYSIS

Visit the website http://www.750words.com

- Click on Log in in the upper right-hand corner and then Sign Up
- Create an account using whichever email you wish
- Once your account is created, Log in
- You should now have a journal-style platform in front of you, with today’s date at the top

Return to your Transcriptions folder

- Choose one of your two sub-folders (Topic Model or Newspaper Title)
- Open the first transcription, select all the text (Cntl+a) and copy it (Cntl+c)

Return to 750words

- Paste the transcription into the entry space (the empty white area in the middle of the screen)
- Click on the word Today at the top left of your screen, and then View Today’s Stats
- This will bring up an analysis, based on the word choice in the text
- Save this report (Cntl+s) as a Webpage, complete
  - Rename the file the appropriate transcription number (9.html)
  - Save it to your desktop, inside the folder Reports
- Return to your entry by clicking on the date at the top of the page

Go through each of the transcriptions in your chosen folder, creating and saving reports in your Reports folder. Once you are done, you can close all your windows and program.
TASK FOUR: ANALYSING SENTIMENT REPORTS

SUB-TASK A: CREATING A DATABASE

Open a new spreadsheet file

- Create the following columns:
  - Transcription No.
  - Year
  - Month
  - Date
  - Newspaper Title
  - Newspaper City
  - Newspaper State
  - Emotion
  - Topic
  - Extrovert/Introvert
  - Positive/Negative
  - Uncertain/Certain
  - Thinking/Feeling
  - Time Orientation
  - Sense
  - Us/Them

Open your Reports folder

- Fill in the relevant transcription numbers

Open your Full Transcription Database (on your desktop)

- Fill in the relevant date and location information for your transcriptions

Open your five (5) reports

- Using the information in each report, fill in the relevant information regarding each transcription

SUB-TASK B: CREATING VISUALISATIONS

Using your reports, create a new spreadsheet with the following style:

<table>
<thead>
<tr>
<th>Transcription No</th>
<th>00010</th>
<th>00002</th>
<th>00021</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affectionate</td>
<td>10%</td>
<td>0%</td>
<td>5%</td>
</tr>
<tr>
<td>Happy</td>
<td>50%</td>
<td>25%</td>
<td>10%</td>
</tr>
<tr>
<td>Self-Expressive</td>
<td>40%</td>
<td>45%</td>
<td>25%</td>
</tr>
<tr>
<td>Self-Important</td>
<td>0%</td>
<td>25%</td>
<td>60%</td>
</tr>
<tr>
<td>Sad</td>
<td>0%</td>
<td>5%</td>
<td>0%</td>
</tr>
<tr>
<td>Anxious</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td>Upset</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
</tr>
</tbody>
</table>

Enter your transcriptions in date order when entering them across the first row. Use your Full Transcription Database to assist you. Using the ‘feeling mostly’ pie charts in your reports, enter in rough percentages for each of the emotions in the appropriate row.

Select your entire table and click on the Insert tab on the top of your screen, followed by Column and the 100% Stacked Column (third option on the first row)

Think of these 10 coloured strips as the emotional barcode for each of your articles. Because you have put the transcriptions in date order, the change from left-to-right will be chronological. How does the emotional state change over time?
TASK FIVE: UNDERSTANDING UP YOUR FINDINGS

SUB-TASK A: US ‘N’ THEM

In order to provide data on your articles, 750words uses two computer analysis programs, the Regressive Imagery Dictionary (for the emotions), and the Linguistic Inquiry and Word Count System. Both of these systems are available commercially, and are far more specific, but these analyses are sufficient to give you an idea of the prevalent themes in your articles.

Using your reports, spreadsheet and any visualisations you have created answer the following questions:

- What is the primary us/them mode of writing for about this topic or within this newspaper?
- What is the primary emotional tone when writing for about this topic or within this newspaper?

The degree to which a newspaper concentrates on the self (or its own group) or on the other (or their perceived group) is important in establishing agency. If there is a consistent trend to focus on the other, it usually implies that they are the ones with agency, the ones making decisions or taking actions. “They are engaging in war” and “We are engaging in war” are not contradictory—both groups could be fighting each other—but there is a suggestion in each about who is instigating the fighting.

Likewise, the primary emotional tone of an article usually tells you how the writer is reacting to the group with agency. If they are anxious and speaking about them, it is likely they are anxious about how they are behaving.

- Based on these two columns in your spreadsheet, what is your hypothesis about whom and how they are writing?

SUB-TASK B: DYING AND KILLING

Open one of the transcriptions, select the text (Cntl+a), copy it (Cntl+c) and paste it into a new Word document (Cntl+v).

Now we are going to label, or code, the document. Take for example, the following passage from Transcription 47:

Lying in bed he discharged his pistol-and-gun, and with each discharge brought down an enemy. So intimidated were the Mexicans by this act of desperate and cool bravery, that they dared not approach him, but shot him from the door; and as the cowards approached his bed over the dead bodies of their companions, the dying Bowie, nerving himself for a last blow, plunged his knife into the heart of his nearest foe at the same instant that he expired.

I have highlighted the active verbs (taking action) in yellow and underlined the passive verbs (receiving action). You can see that the majority of the text is in the active voice, and this is typical of newspaper writing. Authors use the active voice to foreground (make you pay attention to) the person with agency (for example, the hero or villain) rather than the person without it (the victim). In this case, both Bowie and the Mexicans are given the active voice. However, notice that the one case of passive voice is given to the Mexicans (they were intimidated…by Bowie). In this case, the author probably wants you to pay attention to both Bowie and the Mexicans as people with agency, but Bowie is slightly more worthy of notice.

Highlight a few lines of your transcription. Based on your highlighting and underlining, who has the most agency?

Once you have identified who are actors and who are being acted upon, try to assign traits based on word choice. For example, in this case both Bowie and the Mexicans have agency (are acting) but the active verbs describing the Mexicans imply negative traits: they “dared not”, they “approached”, but as cowards, and they “shot” him—thus actively murdered him—as opposed to Bowie, who simply “discharged” his weapon (whether it killed them or not, he was not murdering them).

Looking at the actions taken by those with agency, and the actions taken upon those without it, can you label individuals or groups as heroes, victims and villains?

When put through the 750words analysis, this article was listed as “Upset” and “Negative” in tone. Therefore, although we, as readers, might feel sympathy for Bowie, as a hero actor, the overall tone of the article (based on the number of words) is still negative. This implies that the writer is concentrating on the negative actions of Mexicans, rather than the heroic ones of Bowie. This may be what was meant by the report noting that there was a concentration on “Them”.

But BEWARE! Because this was about Texans fighting Mexicans, the author does not use any words that would make Bowie “one of us” such as “our” or “we”. Thus, “them” is speaking about both groups. The case would be different if the author made explicit who was included in his own group.
SUB-TASK C: WRITING ABOUT DISCOURSE ANALYSIS

At the bottom of your Word Document, begin to write a short paragraph on your findings. You should try to frame your analysis in the following manner:

- Explain the methodological constraints of your analysis (1-2 sentences)
  - What precisely are you looking at in terms of
    - Newspaper titles
    - Dates
    - Topic
    - Which parts of the reports are you looking at (emotion, topic, sense of time, us / them)

- Make an argument regarding your data (1-2 sentences)
  - Is there a clear trend, or does the material seem highly divided?
  - Do the wider trends match up with your close analysis of key vocabulary used?

- Give 1-2 examples from your wider reading / understanding of the topic to put your argument in context
  - What do we know about this topic or trend from lectures or readings
  - Does it appear to conform to these ideas or be an exception

- Give 2 examples from the text or reports that tell you something about these sources, relevant to your argument
  - What is the prevalent emotion (be as specific about percentages as you can) in certain articles. How does this change over time or between newspapers?
    - Include a screen shot of the relevant portion of your report or visualisation (• Make sure to crop the image to the appropriate portion • Select the image in your document, and under the Format tab, choose crop)
  - What are the key sentences, and how can we code them to make better sense of them?

- Explain explicitly how your examples, within the context of your reading or lecture notes, explain your argument

Email your paragraph to me as an attachment. I will read them and send you feedback in the next couple of days.
FINDING SPECIALISED READING

TASK ONE: GATHERING MATERIALS

Visit http://www.gliffy.com
Open your personal Google Drive
- Create a new spreadsheet file
- Name the spreadsheet "Assessment 2 Historiography Search Parameters"

TASK TWO: CREATE A SEARCH PLAN

- What is your research topic? What is the broad area you will be researching?
  
  Topic:
  - What is your research question? What is it about this period or topic that you would like to know more about?
    It should be very specific, and, of course, related to the press coverage of the event or topic.
  
  Research Question:
  - What are the date limits you are likely to want to restrict yourself to?

  Date limits:
  - What are the key concepts you think you will want to discuss? What aspects of social history appear most relevant to your research question (not your topic)? For example, class, gender, social mobility, race?

  Concepts:

TASK THREE: CREATE A SEARCH MIND MAP

- Return to Gliffy.com
- By Dragging and Dropping Basic Shapes from the right-hand sidebar, make a mind-map of keywords
- Place one of your concepts or keywords from your research question into a box. Around it, create bubbles for the following, linking them with the 'connector tool'. You may want to use different shapes or colours for different categories
  
  Broader term: What category does this fall into?
  Abbrev: Is this word commonly abbreviated?
  Antonym: What is the opposite of this?
  Narrower Term: What falls under this category?
  Specialist: Which authors do you know about?
  Synonym: What other words mean roughly the same thing?
TASK FOUR: CRAFTING SEARCH TERMS

- Return to your spreadsheet and head your first column "keywords"
- List all the words on your mind map in that first column, except synonyms, which should go in a row together.
  Separate out any phrases, removing stop words (the, or, that, of) and possessive apostrophes ('s)
  - Indian Amerindian "Native American"
  - Race
  - Fight War Battle
- Which of the words in your mind-map can you truncate (shorten) using an *?
  - Create a new column to the left of all others, (that is, a first column) headed Truncated
  - Race, Racial, Races → Rac*
  - Emigration, Migration, Immigration, Migrants → *migration / *migrant*
- Which of the words in your mind-map are best searched for as phrases?
  - List any phrases you had original separated out as new keywords (second column)
  - Make sure these are placed in speech marks
    - "Red Napoleon"

TASK FIVE: CRAFTING SEARCH PHRASES

Searching a database for relevant materials is more than typing in random keyword. You must craft together searches that will result in the hits most helpful to you.

**AND:** Both words or phrase groups must be included

**OR:** Either word (or both) can appear

**NOT:** The first word or phrase must appear, but the second cannot

In the space below, group different keywords or truncations together with the appropriate Boolean operators. Think carefully about which words will "refine" and which will "open up" your search.

<table>
<thead>
<tr>
<th>AND / OR / NOT</th>
<th>AND / OR / NOT</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND / OR / NOT</td>
<td>AND / OR / NOT</td>
</tr>
<tr>
<td>AND / OR / NOT</td>
<td>AND / OR / NOT</td>
</tr>
<tr>
<td>AND / OR / NOT</td>
<td>AND / OR / NOT</td>
</tr>
<tr>
<td>AND / OR / NOT</td>
<td>AND / OR / NOT</td>
</tr>
<tr>
<td>AND / OR / NOT</td>
<td>AND / OR / NOT</td>
</tr>
<tr>
<td>AND / OR / NOT</td>
<td>AND / OR / NOT</td>
</tr>
<tr>
<td>AND / OR / NOT</td>
<td>AND / OR / NOT</td>
</tr>
</tbody>
</table>
On a new tab in your spreadsheet, list each of these phrases in the first column:

- race OR "skin colour" OR "skin color" NOT "African American" NOT "black" NOT "negro"

- Which types of documents will you searching for, for which situations?
  - Journal articles or
  - Edited collection chapters for
  - Books for
  - Websites for

- What age of material are you looking for?
  - Pre-1900 for
  - 1920-1940s for
  - 1950s-1970s for
  - 1980s-1990s for
  - Post-2000 for

- Which disciplines do you want to limit your search to?
  - History
  - Media studies
  - Anthropology
  - Political science
  - Literature
  - 
  - 

- Which databases do you need to search?
  - Library Gateway
  - JSTOR
  - Google Scholar
  - 
  - 

**TASK SIX: IDENTIFY YOUR SEARCH LIMITS**

Return to your new spreadsheet (with search phrases) and style it he following way:

<table>
<thead>
<tr>
<th>Keyword Phrase</th>
<th>JSTOR</th>
<th>GoogleBooks</th>
<th>Library Gateway</th>
<th>Disciplines</th>
<th>Type Limit</th>
<th>Date Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>N</td>
<td>O</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fill in your first column with your phrases (from TASK FIVE) and your limits (from TASK SIX)

**TASK EIGHT: CREATE YOUR BIBLIOGRAPHY**

- In your Personal Google Drive, create a new document
  - Title it "Assessment 2 Bibliography"
  - Use your table to search your first database for your first phrase
  - Make notes of (in correct bibliography style, not cut and paste) all titles you might possibly find relevant
  - At the end of each entry, write [A] to indicate you searched the first phrase within JSTOR

- For the rest of the seminar, create your specialised bibliography. I will come around to offer advice on your keywords and limits how to improve them
REVIEWING YOUR METHODOLOGIES

TASK ONE: DEFINING YOUR PROJECT

Essay Topic:

Research Question:

Main Points (Sub-Topics) to Address:
1.
2.
3.

TASK TWO: GATHERING MATERIALS

<table>
<thead>
<tr>
<th>Identified</th>
<th>Read</th>
</tr>
</thead>
<tbody>
<tr>
<td>At least one monograph on the period</td>
<td>☐</td>
</tr>
<tr>
<td>At least one monograph on the topic</td>
<td>☐</td>
</tr>
<tr>
<td>An article or essay on first sub-point</td>
<td>☐</td>
</tr>
<tr>
<td>An article or essay on second sub-point</td>
<td>☐</td>
</tr>
<tr>
<td>An article or essay on third sub-point</td>
<td>☐</td>
</tr>
<tr>
<td>1500 words of relevant newspaper material</td>
<td>☐</td>
</tr>
</tbody>
</table>

TASK THREE: CONSIDER POSSIBLE METHODOLOGIES

N.B. All Essays Must include Primary-Historiographical Analysis. This is NOT One of Your Two Methodologies

☐ Editorial-Institutional Biography
- Provide a Detailed Account of an Individual Editor
- Provide a Detailed Account of a Particular Newspaper
- Provide a Detailed Account of a Particular Journalists or Reporter

☐ Geo-Visualisation
- Map Raw (Untranscribed Data) from Chronicling America to Identify Trends with Specific Keywords
- Map Data from Secondary Sources (Battles, Elections, Riots) to Spot Trends within a Topic
- Map Location (Where They Took Place) of Stories on Particular Topics
- Map Location (Where They Were First Printed) of Stories on Particular Topics
- Map Location (Where They Were All Printed) of Stories on Particular Topics
- Map Location (Where They Were Printed) of Stories by a Particular Journalist
- Map Location (Where They Took Place) of Stories by a Particular Journalist
- Compare Maps over Time
- Compare Maps for Different Topics
- Compare Maps for Different Individuals

☐ Reprint Analysis
- Following the Path of a Single Article
- Trace the Origin of Several Articles on the Same Topic to Their Sources
- Examine the Differences in Language in Different Versions of the Article
- Examine the Difference in Length / Focus / Detail in Different Versions of the Article

☐ Discourse Analysis
- Examine the Emotional Content of Key Articles
- Examine the Topic Focus (Money, Success, etc.) of Key Articles
- Examine the Use of Time Signifiers (Past, Future, Present) in Key Articles
- Examine the Use of Us/Them Signifiers in Key Articles
TASK FOUR: DEFINING YOUR FULL METHODOLOGY

- Read Initial Background Material (Lectures, Reading List, Wikipedia)
- Choose Topic
- Begin Initial Search for Newspaper Material
  a) Search Terms:
     i) 
     ii) 
     iii) 
  b) Search Limits:
     i) 
     ii) 
     iii) 
- Begin Initial Search for Secondary Material
  a) Search Terms:
     i) 
     ii) 
     iii) 
  b) Search Limits:
     i) 
     ii) 
     iii) 
- Choose order of analyses and writing (circle or delete as appropriate)
  - Transcribe Articles, Map Raw Data / Map Secondary Data
  - Transcribe Articles / Map Article Data / Map Secondary Data / Analyse Reprints / Examine Biographies / Process Text for Discourse Analysis
  - Transcribe Articles / Map Article Data / Map Secondary Data / Analyse Reprints / Examine Biographies / Process Text for Discourse Analysis
  - Write Up First Draft
  - Read Relevant Secondary Material
  - Transcribe Articles / Map Article Data / Map Secondary Data / Analyse Reprints / Examine Biographies / Process Text for Discourse Analysis
  - Transcribe Articles / Map Article Data / Map Secondary Data / Analyse Reprints / Examine Biographies / Process Text for Discourse Analysis
  - Write Second Draft
  - Read Relevant Secondary Material to Fill in Gaps
  - Complete Essay
  - Proof Read / Format
ANALYSING YOUR WRITING DIGITALLY

TASK ONE: GATHERING MATERIALS

- Open any drafts you have prepared for your assessment
- Open a new Word Document

TASK TWO: ANALYSING YOUR TEXT

Select a body paragraph of your rough draft

- Copy (Cntl+c) the paragraph and paste (Cntl+v) it into your new document
- Close your draft document

Code your paragraph for structure

- At the end of each sentence, start a new line (enter/return)
- In turn, select every full stop or question mark in your document and highlight it yellow
- In turn, select every semi-colon (;) in your document and highlight it red
- In turn, select every colon (:) in your document and highlight it purple
- In turn, select every comma (,) in your document and highlight it blue
- In turn, select every speech mark (“ or ’) and highlight it green

Reconsider your punctuation

- You should only have end punctuation (yellow) at the end of a line
- You should only have a semi-colon (red) if what follows COULD be a new sentence. Could you replace this with a full stop? Would it still make sense? If not, it should be a comma or removed entirely
- You should only have a colon (purple) if you are introducing a list or long quotation. Otherwise, it should be changed to a comma or removed entirely.
- You should only have a comma (blue) if you are making a list or introducing a new clause (a semi-separate thought). If you are starting a new thought (something that could be its own sentence) replace with a full stop
- Double check all your quotations (green). Is the quotation a complete sentence? If so, make sure you have included a full stop in the previous sentence before starting the quotation

If you have added any question marks or full stops, double-check that each sentence is on its own line.

TASK THREE: CODING YOUR TEXT

Open a new Excel document

- Copy (Cntl+c) your sentences into Excel. Double check each sentence is in its own row.

In the second column, label the type of each sentence

- If the sentence was written entirely by you, and represents your own thoughts, label “own”
- If the sentence is a quotation or paraphrase from a secondary source, label “secondary”
- If the sentence is a quotation or a paraphrase form a primary source, label “primary”

Most of your sentences should be labeled secondary or primary.
In the third column, label the purpose of this sentence

- If the sentence is introducing the purpose of the paragraph, label “topic”
- If the sentence is introducing an argument or assertion, label “point”
- If the sentence is providing direct evidence (an example), label “example”
- If the sentence is providing a historian’s opinion or argument, label “historiography”
- If the sentence is examining or analysing an example, label “analysis”
- If the sentence is comparing or contrasting several pieces of evidence, or making a wider analysis of several pieces of evidence, label “wider analysis”
- If the sentence is explaining how all the evidence in the paragraph fits together or proves the point, label “concluding thought”

In the fourth column, place an ”X” if the sentence currently has a footnote attached to it

**TASK FOUR: MAKING TOUGH DECISIONS**

A sentence should rarely have more than 25 words.

- Maximise your spreadsheet to full screen
- Expand the first column so that every sentence fits within it (double click the line between “A” and “B”)
- If any of your sentences take up more than 80% full screen, or goes off the side of the screen, either
  - Make the sentence more concise
  - Split the sentence into two or three new sentences
  - Call me over and justify why it is so long

A paragraph for your research essay should have the following:

- A topic sentence
- At least one (1) point or argument about that topic
  - This may, on occasion, be replaced by a historian’s opinion (footnoted)
- At least two (2) examples from different secondary sources (footnoted)
- At least one (1) analysis of secondary material
- At least one (1) example from a primary source (footnoted)
- At least one (1) analysis of the primary material
- At least one sentence (1) providing a wider analysis of the secondary and primary material
- A concluding thought that explains how the examples prove your "point" or "historiography"

What is your paragraph missing? What will you add?
What does your paragraph look like?
FORMATTING YOUR WORK DIGITALLY

TASK ONE: GATHERING MATERIALS
Open your draft assessment
- Save the document to your desktop in this format: FLast_Topic_20140313.docx

TASK TWO: FORMATTING YOUR TEXT
Format the document to the following specifications using the "Home" tab in Word
- Click on the Change Style button, followed by Style Set and choose Word 2010
- At the top of your page, on its own line, write a topic of your essay (The Alamo, The Fugitive Slave Act, etc)
  - Highlight the line with your title, and select the Title button within the Styles section of the top menu ribbon
- On a new line under your title, write a subtitle – the specific title of your essay
  - Highlight the line with your subtitle and select the Subtitle button on the style selector
- On a new line under your subtitle, write your full name
  - Highlight the line with your name and select Normal in the style selector
- On a new line under your name, write a heading, the topic of your paragraph or section (i.e. Introduction)
  - Highlight the line with your subtitle and select Heading 1 button (or use Cntl+alt+1)
- Make sure there are no empty lines between your Title, Subtitle, Heading and paragraph text
- Place your cursor within the paragraph text
  - Select the Normal button on your style selector
  - Change line spacing to 1.5 spacing (Cntl+5)
  - Change the font to Calibri, 11 pt font
  - Right-click the Normal button and select Update Normal to Match Selection
  - You can now use the Normal button to format any normal paragraph text in your essay
- Highlight your title, subtitle and name, and centre the text (Cntl+e)
- Select all text (Cntl+a)
  - Ensure there is no hanging indent by making sure the arrows on the ruler are at zero
  - If you cannot see the ruler, go to View and tick the Ruler tick box
Format the document to the following specifications using the "Page Layout" tab in Word

- Choose the Black Tie theme from the Themes Button
- Change margins to Normal
- Select all the text (Cntl+a)
- Ensure both Indent boxes and the top Spacing box reads 0 pt
- Change the bottom Spacing box to 6 pt

Format your footnotes using the following specifications

- If you don’t have any footnotes yet, create one (Cntl+alt+f) at the end of your first sentence and type in Footnote Placeholder Text in the footnote
- Click on a part of your footnote text and then select all (Cntl+a)
- Change the font to Calibri, 10 pt font
- Change the font colour to Black (not automatic)
- Remove any underlining (Cntl+u, twice)
- Make single spaced (Cntl+1)
- On the Page Layout tab
  - Change the indent boxes to 0 cm
  - Change the spaces boxes to 0 pt

**IF YOU HAVE A QUOTATION WHICH IS LONGER THAN 4 LINES OR 50 WORDS**

- Start and end the quotation on a new line (separate from the paragraph)
- Remove the quotation marks, keeping the footnote at the end. after the full stop
- Highlight the quotation text
  - Change to single spacing (Cntl+1)
  - On the Page Layout tab, change both Indent boxes to 1.5 cm
  - Change the bottom Spacing box to 12 pt
- Un-highlight the quotation, and click on a part of it which is not bolded or italicised
  - Return to Home Tab and right click on Intense Quote in the style selector
  - Select Update Intense Quote to Match Selection
  - You can now use the Intense Quote button for all future long quotations

Create a new PAGE at the end of the document (Cntl+end, Cntl+enter)

- Write a new line that reads Bibliography
  - Highlight the line and select Heading 1 from the style selector (Cntl+alt+1)
    - Centre the text (Cntl+e)
  - Write a new line that reads Newspaper Articles
  - Write a new line that reads Secondary Sources
    - Highlight both these lines and select Heading 2 from the style selector (Cntl+alt+2)
• Starting on a new line under Newspaper Articles, type out (or paste in) the bibliographic references for all newspaper articles that are currently in your essay
  o Use the format: Last, First. “Headline, if present” Newspaper Title, DD Month YYYY, p. #.
  o Remove any extra lines between entries
  o Make sure you have not included any numbering or bullet points

• Starting on a new line under Secondary Works, type out or paste in the bibliographic references for all citations that are currently in your essay
  o Remove any extra lines between entries
  o Make sure you have not included any numbering or bullet points

Format your entries according to the following specifications. Do each list (Newspapers / Secondary) separately
  o Highlight all the Bibliography text (excluding the header)
  o Select Normal from the style selector
  o Make single-spaced (Cntl+1)
  o Open the paragraph style menu (right-click and select Paragraph)
    ▪ Under Special, change to Hanging and select OK
  o Press Sort (AZ↓) Button and select Paragraphs and Ascending
  o Double check all book and newspaper titles remained italicised

On the Insert tab, select Page Number, Bottom of Page, Plain Number 2

TASK THREE: PREPARING IMAGES

SUB-TASK A: OBTAINING IMAGES

Decide on an image or figure to include in your essay
  • A graph or chart you have created based on your data
    o Make as large as possible on your screen (zoom in) and then take a screen capture (Print Screen)
  • A map you have created based on your data
    o Take a screen capture (Print Screen) from BatchGeo
  • An image that depicts something you are writing about
    o Visit http://commons.wikimedia.org to search for an appropriate image
    o Right click on the image and copy image
  • A table you have created based on your data
    o Highlight your table and copy (Cntl+c)
SUB-TASK B: CREATING DOCUMENT-FRIENDLY IMAGES

If you are using a table, continue to Sub-Task C

If you are using a screen capture of an image, map, or chart

- Open the Paint program from the start menu
- Paste (Cntl+v) your image into Paint
- Crop your image to the correct size:
  - Select your image (Cntl+a) and then move it up and to the left until the top left corner of the image you want is in the top left corner of the paint canvass window
  - Click and hold the bottom right corner of the paint canvass (your image). A small, white set of diagonal arrows should appear.
  - Resize the canvass so only the part of the image you want is visible
- Save the image as essayimage1.png on your desktop

SUB-TASK C: FORMATTING IMAGES

Decided where to insert your image or table

- If the image is crucial to understanding the text, or will greatly help your reader, it should be included in the text
- If the image or table is simply ‘additional information’, which your reader may want to refer to, it should be included in an appendix

In-Text Images

- Go to the start of the paragraph in which you speak about your image or graph
  - Create a new line before the paragraph
  - Go to the Insert tab and select Picture
    - Choose your image file from your desktop and click Insert
- Select your image and go to the pink Picture Tools: Format tab
  - If the image is wider than it is tall, change the image size to 14 cm wide (the bottom box)
  - If the image is taller than it is wide, change the image size to 8 cm tall (the top box)
  - Adjust as necessary to fit without extraneous white space or making the image un-viewable
  - Centre the image (Cntl+e)
- Right click the image and select Insert Caption and change the caption text in one of the following styles
  - For a Graph:
    - Figure 1: Change in Emotional Content, The Anti-Slavery Bugle, 1840-1860. Data derived from Press and American Society Transcription Database, processed through the Regressive Imagery Dictionary.
  - For an Image:
    - Figure 1: A View of the Battle Site of Little Big Horn, Wikimedia Commons, Accessed 11 March 2014 at http://commons.wikimedia.org/wiki/File:Sanderson_camp_at_Little_Big_Horn.jpg
  - For a Map:
    - Figure 1: Dispersal of Accounts Regarding the Battle of the Alamo, 1836-1846. Data derived from the Press and American Society Transcription Database, processed through BatchGeo.
In-Text Tables

- Go to the start of the paragraph in which you speak about your table
  - Create a new line before the paragraph
  - Paste (Cntl+v) your table information
  - Select your table (click on the table, and then on multi-directional arrow icon in the top-left corner)

- Go to the yellow Table Tools: Design tab
  - Make sure your Header Row and First Column boxes are ticked (if that column/row has labels)
  - Use Banded Columns or Banded Rows as appropriate to your data
  - Choose any Black and White table style you wish

- On the Table Tools: Layout tab
  - Click on AutoFit, Autofit to Window

- With the table selected, right click the table and select Insert Caption
  - Change the caption text in the following styles
    - Table 1: Change in Emotional Content, *The Anti-Slavery Bugle*, 1840-1860. Data derived from Press and American Society Transcription Database, processed through the Regressive Imagery Dictionary

In Appendices

- Add a new page before your bibliography (Cntl+enter)
- Write a new line that reads Appendices
  - Highlight the line and select Heading 1 from the style selector (Cntl+alt+1)
  - Centre the text (Cntl+e)
- Write a new line that reads Appendix 1: Title of your Image or Figure, including data details (see above)
  - Highlight the line and select Heading 2 from the style selector (Cntl+alt+2)
  - Make sure the heading text is single spaced (Cntl+1) if it is more than one line long
  - Insert your image below the heading
- Select your image and go to the pink Picture Tools: Format tab
  - If the image is wider than tall, change the image size to 14 cm wide (the bottom box)
  - If the image is taller than wide, change the image size to 14 cm tall (the top box)
  - Adjust as necessary to fit on your page without extraneous white space or making the image un-viewable

Save the document to your university Documents folder as well as any portable media you have (USB stick)
PRESENTING YOUR WORK ONLINE

TASK ONE: GATHERING MATERIALS
Open any notes, drafts, spreadsheets or other materials you have prepared for you assessment
Open a Chrome Browser and visit http://sites.google.com

- Log-in with your university details

TASK TWO: CREATING YOUR SITE
Select create (red button on the left of your screen)

- Use a Blank Template and name your site your Title
- Select a theme (I suggest one of the coloured ‘Solitude’ options)
- Hit the red Create button at the top of your screen

TASK THREE: POPULATING YOUR SITE
Once your page is created, click on the Edit Page button (or press ‘e’)

- Select your entire Word Document file (Cntl+a) and copy it (Cntl+c)
- Paste your document into the main content area of your website (Cntl+v)
  - Delete the title, horizontal line and your name
  - Cut (Cntl+x) the subtitle and paste it (Cntl+v) to replace the word Home at the top of your page
    - Your page should now start with the Heading
  - Delete any images or tables (but leave in the captions)
  - Delete the bibliography and any appendices, but leave in your footnotes

Format your text according to the following:

- Highlight all the text (Cntl+a) and select the Remove Formatting button (Tx)
- Highlight your heading and select Format at the top of your screen, and choose Sub-Heading H3
- Highlight any long quotations you have and select Increase Indent button
- Add a line after your main text, but before your footnotes, that reads References
  - Highlight this and select Format, Minor Heading H4
- Remove an extraneous empty lines
  - There should be no empty lines (that you can remove) between your heading and text
  - There should be only one line between paragraphs
  - There should be no lines between footnotes
TASK FOUR: ILLUSTRATING YOUR SITE

Go to any image or figure caption you have on your page, and create an additional blank line above it

- Highlight the caption text, and copy it (Cntl+c)
- Go to the blank line and click Insert, Image
  - Upload your image
  - In the Alt Text box, paste (Cntl+v) your caption text
  - Select OK
  - Centre the image using the Align Center button, visible when you click on the image
  - Remove any empty lines between the image and caption
  - Centre the caption text using the Align Centre button at top of editor

Go to any table caption you have on your page, and create an additional blank line above it

- Highlight the caption text, and copy it (Cntl+c)
- Go to the blank line and click Table, Insert Table and select the correct size
  - Enter (or copy and paste) your table information
  - Remove any empty lines between the table and caption
  - Select the table and caption and centre them using the Align Centre button at top of editor

Reintegrate any images or captions that you had originally left in the appendices of your Word Document

SUB-TASK D: HYPERLINKING YOUR SITE

Go to your references section

- In turn, highlight each individual reference, excluding the footnote number, and click on the Link button at the top of the editor

In a new tab, visit Google Scholar (http://scholar.google.com)

- Search for the book or journal article
  - When you find it, click on the entry to see if a preview appears, such as JSTOR or Google Books
  - If so, copy the permanent URL
    - In Google books, click on the Link button and copy the top link
    - In JSTOR or other article repositories, look for the Stable URL
  - If not, ignore this reference and move onto the next

Return to the tab with your webpage

- Paste the link into the box
  - Tick the Open in New Window box
  - Click OK

SUB-TASK E: PUBLISHING YOUR PAGE TO A PRIVATE VIEWER

Select Share and add my email address only
VISUALISING YOUR RESEARCH FOR EMPLOYERS

In Chrome, visit http://re.vu

Create a new account using a personal email address (that you will have access to after graduation)

- Skip the LinkedIn Step (unless you already have a completed LinkedIn Account)
- Enter your basic information
- Pay careful attention to the “allow visitors to contact via your email” tick box
- Ignore the options to upload resume / photo
- Click the green “Save” button the on left-hand side

You can now see your online resume. Click on “My Profile” in the upper right-hand side, and then “Edit Profile”

Click on Infographics

- Go to Proficiencies

  Think about the skills you have gained while undertaking this module or your degree
  
  - Archival Research (Have you done research inside a traditional archive?)
  - Digital Research (Did you use the Chronicling America Database?)
  - Genealogical Research (Did you research the family or history of editors?)
  - Data Entry (Did you enter data into the Full Transcription Database?)
  - Database Creation (Did you create your own spreadsheet for your essay or group?)
  - Discourse Analysis (Did you study the word-choice or writing style of the articles?)
  - Sentiment Analysis (Did you use 750 words on any documents? Set at Max 5 Below)
  - Geo-Visualisation (Did you use BatchGeo?)
  - Social Network Analysis (Did you study the spread of news between newspapers? Set at Max 5 Below)
  - Written Communication (Did you write any essays or reports?)
  - Oral Communication (Have you done any presentations?)
  - Teamwork (Have you done any collaborative work?)

Enter any skills you have under Job Skill

- You should only list skills you feel comfortable discussing at an interview and performing on the job, albeit with some additional training
- Enter a value that represents your level of comfort with that skill
  
  - 1 – Basic understanding
  - 5 – Comfortable with concepts, can do with supervision or additional training
  - 6 – Have experience (coursework) of successfully doing this work
  - 7 – Have multi-experiences of successfully (2:1+) doing this work
  - 8 – Have consistent experience of successfully (2:1+) doing this work
  - 9 – Could do this without additional supervision or training
  - 10 – Expert (Could take a test at the interview and pass without worry)

- Click Save and enjoy your proficiency chart

Click on “My Profile” in the upper right-hand side, and then “Edit Profile”

- Go to Work Examples
  
  You could upload (corrected, post-feedback) examples of your written work here

- Go to Portfolio
  
  You could upload images of your visualisations from your essays that you are particular proud of

- Play around with other parts of your Re.Vu resume. Keep or Delete at the end of the seminar